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Available Bookmark Fields




The items listed in the tables below are all recognized by MoversSuite and contain the actual bookmark links, so that they can just be copied from here and placed directly into your own bookmark documents.  

The bookmark fields must be selected and pasted exactly as they appear within the listing.  
Adding Available Bookmark fields to another Bookmark Document

1. Open or create a document using Microsoft Word
2. Open this document as a Microsoft Word document available through the 
 link
3. Locate a desired bookmark field and select it by using the mouse to double-click it or by selecting the entire word by holding the mouse down and highlighting the entire bookmark field
4. Copy (CTRL+C) the bookmark field
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Figure 1: Selecting bookmark example
Note: The image in Figure 1 (above) has the Microsoft Word option of Show Bookmarks turned on.  In Microsoft Office Word, this option is available by Office Button > Word Options > Advanced > Show Document Content > Show Bookmarks.
5. Paste (CTRL+V) the field into place within the target document
Important: Bookmarks are not case-sensitive, however, they cannot be altered.  For instance, the bookmark that retrieves the shipper’s first name is “FirstName” and can be entered as “firstname” but will not work if it is “first name” (space added).  
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Figure 2: Sample of bookmark paste
6. Verify that the bookmark field copied correctly by opening the Bookmark dialog by Microsoft Word >Insert > Bookmark and confirming that the Bookmark name is listed
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Figure 3: Bookmark dialog
7. Repeat Steps 3 through 6 to include other bookmark fields
Important: Bookmark fields can only be used once.  If two entries exist for the FirstName bookmark, for example, then only the first occurrence of the bookmark in the document will be repainted with the shipper’s first name.
Refer to the Bookmarks topic in the online help to define the updated, or new, document to be recognized and accessible through MoversSuite.   Once the administrative setup is complete, then the user can verify the output of the document by generating it through MoversSuite.

In the following sections, a user can find all available bookmark fields to access MoversSuite data within their own documents.  In all cases, a user must be accessing a record within MoversSuite in order for data to display correctly.
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Standard Bookmark Fields
Listed within this section are all available bookmarks fields associated to a general MoversSuite order record.  
General Order Information Fields

	MoversSuite Data
	Bookmark Field
	Location in MoversSuite

	Order Number 
	ordnum 

ordern
	Information Bar 

	National Account Number 
	acctno
	Billing Information 

	National Account Name 
	Acctname
	Billing Information 

	Shipper First Name 
	FirstName
	Name, Address, Phone 

	Shipper Last Name 
	LastName
	Name, Address, Phone 

	Shipper Full Name 
	fname  

FirstName2  

Shipper
	Name, Address, Phone 

	Branch Name 
	blname
	Information Bar

	Branch Street 
	baddr
	MoversSuite Administration > Branch Setup

	Branch City, State Zip 
	bcsz
	MoversSuite Administration > Branch Setup

	Branch Phone 
	bphone
	MoversSuite Administration > Branch Setup

	Branch Phone Extension 
	bphonex
	MoversSuite Administration > Branch Setup

	Branch Fax 
	bfax
	MoversSuite Administration > Branch Setup

	Work Ticket Title 
	Bname
	MoversSuite Administration > Branch Setup

	Logistics Coordinator 
	LogisticsCoordinator
	Name, Address, Phone


Date and Time Fields
	MoversSuite Data
	Bookmark Field
	Location in MoversSuite

	First Day of Packing Spread 
	pdate
	Move Information

	Last Day of Packing Spread 
	pdate2
	Move Information

	First Day of Loading Spread 
	ldate
	Move Information

	Last Day of Loading Spread 
	 ldate2
	Move Information

	First Day of Delivery Spread 
	ddate
	Move Information

	Last Day of Delivery Spread 
	ddate2
	Move Information

	Loading Time 
	ltime
	Set through a van line upload

	Delivery Time 
	dtime
	Set through a van line upload

	Today’s Date 
	date
	System-computed


Origin Fields
	MoversSuite Data
	Bookmark Field
	Location in MoversSuite

	Origin Complete Address 
	oaddress
	Name, Address, Phone tab > Moving From section

	Origin Address Line #1 

Origin Address Line #1 

Origin Address Line #2 

Origin Address Line #3
	MovingFrom

MovingFromAddr1

MovingFromAddr2

MovingFromAddr3
	Name, Address, Phone tab > Moving From section

	Origin City 
	City 

ocity

city2
	Name, Address, Phone tab > Moving From section

	Origin State 
	state
	Name, Address, Phone tab > Moving From section

	Origin Zip Code 
	Zip
	Name, Address, Phone tab > Moving From section

	Origin Country 
	OriginCountry
	Name, Address, Phone tab > Moving From section

	Origin Country Code 
	OriginCountryCode
	Name, Address, Phone tab > Moving From section

	Origin Home Phone 
	phoneh
	Name, Address, Phone tab > Moving From section

	Origin Work Phone 
	phonew
	Name, Address, Phone tab > Moving From section

	Origin Work Extension 
	Phonewext
	Name, Address, Phone tab > Moving From section

	Origin Agency ID 
	Oaagent 
	Agents tab > Origin Agent section

	Origin Agency Name 
	oaname
	Agents tab > Origin Agent section

	Origin Agency Street 
	oaadd
	Agents tab > Origin Agent section

	Origin Agency City 
	oacity
	Agents tab > Origin Agent section

	Origin Agency State 
	oastate
	Agents tab > Origin Agent section

	Origin Agency Zip 
	oazip
	Agents tab > Origin Agent section

	Origin Agency Phone 
	oanum  

oanumber  

oaphone
	Agents tab > Origin Agent section

	Origin Agency Contact 
	oacontact
	Agents tab > Origin Agent section


Destination Fields
	MoversSuite Data
	Bookmark Field
	Location in MoversSuite

	Destination Complete Address 
	daddress  
	Name, Address, Phone tab > Moving To section

	Dest. Address Line #1
Dest. Address Line #1
Dest. Address Line #2

Dest. Address Line #3 
	MovingTo

MovingToAddr1

MovingToAddr2

MovingToAddr3
	Name, Address, Phone tab > Moving To section

	Destination City 
	dcity 

 DestCity
	Name, Address, Phone tab > Moving To section

	Destination State 
	dstate
	Name, Address, Phone tab > Moving To section

	Destination Zip Code 
	dzip
	Name, Address, Phone tab > Moving To section

	Destination Country 
	DestinationCountry
	Name, Address, Phone tab > Moving To section

	Destination Country Code 
	DestinationCountryCode
	Name, Address, Phone tab > Moving To section

	Destination Work Phone 
	Dphonew
	Name, Address, Phone tab > Moving To section

	Destination Agent Name 
	daname
	Agents tab > Destination Agent section

	Destination Agent ID 
	daagent
	Agents tab > Destination Agent section

	Destination Agent Street 
	daadd
	Agents tab > Destination Agent section

	Destination Agent City 
	dacity
	Agents tab > Destination Agent section

	Destination Agent State 
	dastate
	Agents tab > Destination Agent section

	Destination Agent Zip Code 
	dazip

	Agents tab > Destination Agent section

	Destination Agent Phone
	danum
	Agents tab > Destination Agent section


Consignor/Consignee Fields

	Item Description
	Bookmark Field
	Location in MoversSuite

	Consignor Name 
	Consignor
	Name, Address, Phone tab > Consignor dialog

	Contact Name 
	ConsignorContact
	Name, Address, Phone tab > Consignor dialog

	Contact Phone (w/Extension) 
	ConsignorPhone   
	Name, Address, Phone tab > Consignor dialog

	Consignee Name 
	Consignee
	Name, Address, Phone tab > Consignee dialog

	Contact Name 
	ConsigneeContact
	Name, Address, Phone tab > Consignee dialog

	Contact Phone (w/Extenstion) 
	ConsigneePhone  
	Name, Address, Phone tab > Consignee dialog


Customer (Bill To) Fields

	MoversSuite Data
	Bookmark Field
	Location in MoversSuite

	Customer Name 
	CustomerName
	Billing Information tab

	Bill To Address 
	CustomerBillToAddress
	Billing Information tab

	Bill To City 
	CustomerBillToCity
	Billing Information tab

	Bill To State 
	CustomerBillToState
	Billing Information tab

	Bill To Postal Code  
	CustomerBillToPostalCode
	Billing Information tab


Booking Fields

	MoversSuite Data
	Bookmark Field
	Location in MoversSuite

	Booking Agent Name 
	BookAgentName
	Agents tab > Booking Agent section

	Booking Agency ID 
	Book

Note: If Booking Agency ID is not set, then the Origin Agent ID will be used instead.
	Agents tab > Booking Agent section

	Booking Agency Salesperson 
	sales 

SalesPerson
	Name, Address, Phone tab > Salesperson field

	Booking Salesperson’s Email 
	SalesEmail    
	MoversSuite Administration > User Setup > Personnel record for the Booking Agency Salesperon

	Booking Agency Coordinator 
	coord  

coord2  

coord3 
	Name, Address, Phone tab > Transportation Coordinator

	Booking Coordinator’s Email 
	coordemail  

email1  

email2
	MoversSuite Administration > User Setup > Personnel record for the Booking Coordinator

	Booking Coordinator’s Fax Number 
	coordfax
	MoversSuite Administration > User Setup > Personnel record for the Booking Coordinator

	Booking Coordinator’s Phone 
	coordphone
	MoversSuite Administration > User Setup > Personnel record for the Booking Coordinator

	Booking Coordinator’s Phone Ext 
	coordphoneext
	MoversSuite Administration > User Setup > Personnel record for the Booking Coordinator


Claims Bookmark Fields
Listed here are the bookmarks available that contain data specific to the Claims interface and related functionality.

A user must be accessing an active Claim record within the Claims interface in order to have data display for these bookmarks correctly.

	MoversSuite Data
	Bookmark Field
	Location in MoversSuite

	Claim Number
	ClaimNumber
	Claim Detail dialog

	Claim Type
	ClaimType
	Claim Detail dialog

	Claim Adjuster
	ClaimAdjuster1

ClaimAdjuster2

 ClaimAdjuster3
	Claim Detail dialog

	 Claim Items


	ClaimItems

The following data will display for each record associated to a Claim when this bookmark field is in use 

· Description

· Claim Damage Type

· Claim Amount

· Settlement Amount


	Claim Items section

	Claim Status
	ClaimStatus
	Claim Detail dialog

	Valuation Description
	ValuationDescription
	Claim Detail dialog

	Declared Amount
	DeclaredAmount
	Claim Detail dialog

	Shipper Deductible
	ShipperDeductible
	Claim Detail dialog

	Alert Received Date
	AlertReceived
	Date assigned to the initial Claim Alert issued (Tools > Claim Alert)

	Claim Opened Date
	ClaimOpened
	Claim Detail dialog

	Claim Closed Date
	ClaimClosed
	Claim Detail dialog (set when the Status of the claim is set to “Closed”)

	Settlement Amount
	SettlementAmount
	Claim Detail dialog

	Claimant Name 
	Claimant
	Claim Detail dialog

	Claimant Street Address 
	ClaimantAddress
	Claim Detail dialog

	Claimant City 
	ClaimantCity
	Claim Detail dialog

	Claimant State 
	ClaimantState
	Claim Detail dialog

	Claimant Country 
	ClaimantCountry
	Claim Detail dialog

	Claimant Zip 
	ClaimantZip
	Claim Detail dialog


International Bookmark Fields
Listed here are the bookmarks available that contain data specific to an International record.

A user must be accessing an active International record in order to have data display for these bookmarks correctly.

General Shipping Fields
	MoversSuite Data
	Bookmark Field
	Location in MoversSuite

	Booking Number 
	BookingNumber
	Shipping Information tab > Booking Number dialog

	Departure Port 
	DeparturePort
	Shipping Information tab > Other Information section

	Final Destination Port 
	DestinationPort
	Shipping Information tab > Other Information section

	Airway or Seaway Bill Number 
	AirwayBill
	Shipping Information tab > Other Information section

	Airway Consolidator Bill (HAWB)  
	ConsolidatorAirwayBill
	Shipping Information tab > Other Information section

	Vessel/Flights Info 


	VesselandFlightInfo

The following data will display for each record associated to an Order when this bookmark field is in use:
· Vessel/Flight

· Estimated Departure Date

· Actual Departure Date

· Estimated Arrival Date

· Actual Arrival Date

· Destination Port
	Shipping Information tab

Note: Set through a van line upload

	Ready To Go Date 
	ReadyToGoDate
	Shipping Information tab

	Depart Origin Port Date 
	DateDepartOriginPort
	Shipping Information tab

	 Arrive Destination Port Date 
	DateArriveDestinationPort
	Shipping Information tab


Originating Line Haul Agent Fields
	MoversSuite Data
	Bookmark Field
	Location in MoversSuite

	Agent Name 
	OriginLinehaulAgentName
	Shipping Information tab > Service Provider section

	Street Address 
	OriginLinehaulAgentStreetAddress
	Shipping Information tab > Service Provider section

	City 
	OriginLinehaulAgentCity
	Shipping Information tab > Service Provider section

	State 
	OriginLinehaulAgentState
	Shipping Information tab > Service Provider section

	Country Name 
	OriginLinehaulAgentCountry
	Shipping Information tab > Service Provider section

	Postal Code 
	OriginLinehaulAgentPostalCode
	Shipping Information tab > Service Provider section


Carrier Fields
	MoversSuite Data
	Bookmark Field
	Location in MoversSuite

	Carrier Name 
	IntlCarrierName
	Shipping Information tab > Service Provider section

	Street Address 
	IntlCarrierStreetAddress
	Shipping Information tab > Service Provider section

	City 
	IntlCarrierCity
	Shipping Information tab > Service Provider section

	State 
	IntlCarrierState
	Shipping Information tab > Service Provider section

	Country Name 
	IntlCarrierCountry
	Shipping Information tab > Service Provider section

	Postal Code 
	IntlCarrierPostalCode
	Shipping Information tab > Service Provider section


Consolidator Fields
	MoversSuite Data
	Bookmark Field
	Location in MoversSuite

	Consolidator Name 
	ConsolidatorName
	Shipping Information tab > Service Provider section

	Street Address 
	ConsolidatorStreetAddress
	Shipping Information tab > Service Provider section

	City 
	ConsolidatorCity
	Shipping Information tab > Service Provider section

	State 
	ConsolidatorState
	Shipping Information tab > Service Provider section

	Country Name 
	ConsolidatorCountry
	Shipping Information tab > Service Provider section

	Postal Code 
	ConsolidatorPostalCode
	Shipping Information tab > Service Provider section


Customs Agent Fields
	MoversSuite Data
	Bookmark Field
	Location in MoversSuite

	Customs Agent Name 
	CustomsAgentName
	Shipping Information tab > Service Provider section

	Street Address 
	CustomsAgentStreetAddress
	Shipping Information tab > Service Provider section

	City 
	CustomsAgentCity
	Shipping Information tab > Service Provider section

	State 
	CustomsAgentState
	Shipping Information tab > Service Provider section

	Country Name 
	CustomsAgentCountry
	Shipping Information tab > Service Provider section

	Postal Code 
	CustomsAgentPostalCode
	Shipping Information tab > Service Provider section


Destination Line Haul Agent Fields
	MoversSuite Data
	Bookmark Field
	Location in MoversSuite

	Destination Line Haul Agent Name 
	DestinationLinehaulAgentName
	Shipping Information tab > Service Provider section

	Street Address 
	DestinationLinehaulAgentStreetAddress
	Shipping Information tab > Service Provider section

	City 
	DestinationLinehaulAgentCity
	Shipping Information tab > Service Provider section

	State 
	DestinationLinehaulAgentState
	Shipping Information tab > Service Provider section

	Country Name 
	DestinationLinehaulAgentCountry
	Shipping Information tab > Service Provider section

	Postal Code 
	DestinationLinehaulAgentPostalCode
	Shipping Information tab > Service Provider section


Pickup From Fields
	MoversSuite Data
	Bookmark Field
	Location in MoversSuite

	Pickup From Name 
	PickupFromName
	Shipping Information tab > Booking Number dialog

	Pickup Number 
	PickupNumber
	Shipping Information tab > Booking Number dialog

	Street Address 
	PickupFromStreetAddress
	Shipping Information tab > Booking Number dialog

	City 
	PickupFromCity
	Shipping Information tab > Booking Number dialog

	State 
	PickupFromState
	Shipping Information tab > Booking Number dialog

	Country Name 
	PickupFromCountry
	Shipping Information tab > Booking Number dialog

	Postal Code 
	PickupFromPostalCode
	Shipping Information tab > Booking Number dialog

	Phone Number 
	PickupFromPhone
	Shipping Information tab > Booking Number dialog


Return To Fields
	MoversSuite Data
	Bookmark Field
	Location in MoversSuite

	Return To Name 
	ReturnToName
	Shipping Information tab > Booking Number dialog

	Street Address 
	ReturnToStreetAddress
	Shipping Information tab > Booking Number dialog

	City 
	ReturnToCity
	Shipping Information tab > Booking Number dialog

	State 
	ReturnToState
	Shipping Information tab > Booking Number dialog

	Country Name 
	ReturnToCountry
	Shipping Information tab > Booking Number dialog

	Postal Code 
	ReturnToPostalCode
	Shipping Information tab > Booking Number dialog

	Phone Number 
	ReturnToPhone
	Shipping Information tab > Booking Number dialog


Consign Bill of Lading To Fields
	MoversSuite Data
	Bookmark Field
	Location in MoversSuite

	Consign Bill of Lading To Name 
	ConsignToName
	Shipping Information tab > Consign BOL dialog

	Street Address 
	ConsignToStreetAddress
	Shipping Information tab > Consign BOL dialog

	City 
	ConsignToCity
	Shipping Information tab > Consign BOL dialog

	State 
	ConsignToState
	Shipping Information tab > Consign BOL dialog

	Country Name 
	ConsignToCountry
	Shipping Information tab > Consign BOL dialog

	Postal Code 
	ConsignToPostalCode
	Shipping Information tab > Consign BOL dialog

	Phone Number 
	ConsignToPhone
	Shipping Information tab > Consign BOL dialog

	Fax Number 
	ConsignToFax

	Shipping Information tab > Consign BOL dialog


Quote Bookmark Fields

Listed here are the bookmarks available that contain data specific to a Quote record. 

	MoversSuite Data
	Bookmark Field
	Location in MoversSuite

	Quotes


	QuoteTable

When this bookmark is selected, all Quotes and all Quote Detail records associated to an Order will be listed.  

The following data will appear for each Quote record (by detail or grouped record):

· Quote Description

· Charge

· Rate

· Quantity

· Vendor Quoted Charge

· Vendor Actual Charge

· Rate Type

· Item Code

· Service Provider Type
	Quote tab


Special Services Bookmarks
Listed here are the bookmarks available that contain data specific to a Special Service record.

A user must be accessing an active Special Services record in order to have data display for these bookmarks correctly.

	MoversSuite Data
	Bookmark Field
	Location in MoversSuite

	Stores Information
	Stores

Data related to all jobs associated to a Special Services order within the Store Information tab will display when this bookmark field is referenced.

The following data will display for each record associated to an Order when this bookmark field is in use 

· Install Date 

· Install Time

· Store Name

· Store Number

· Store Address

· Story City, State and Zip

· Store Contact

· Store Phone
	Store Information tab
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